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Lesson 4: Data Analysis 
Lesson Objectives 
In this lesson, you will work with a variety of tools to help analyze data in different ways, including 

setting up and resolving what-if scenarios, working with data tables, and using advance filtering. 

You will also use PivotTables, Slicers, and outlining to reorganize and group the data in different 

ways to help you in your analysis. On successful completion of this lesson, you should be able to: 

 set up a what-if scenario with a worksheet 

 use the Goal Seeking tool 

 use the Solver tool 

 create a data table with one or two variables 

and with multiple formulas 

 use the Analysis ToolPak 

 use array formulas 

 outline and group data using automatic 

subtotals 

 outline and group data manually by 

inserting subtotals 

 use advanced filter options to search for 

data 

 create PivotTables and PivotCharts and 

manipulate the PivotTable 

 use the Slicer with a PivotTable 

 use cube functions 
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What-If Analysis 
One of the most common applications for spreadsheets is a what-if analysis, which gives you the ability to 

pursue an almost endless series of trial-and-error scenarios using a variety of numbers and formulas. When 

spreadsheet programs were introduced, they almost instantly rendered the traditional manual method 

obsolete even with the help of handheld calculators because spreadsheets could recalculate a large 

number of formulas and display the results simultaneously. This capability saved a tremendous amount of 

manual work and virtually eliminated calculation errors. 

 

Suppose your company, Tolano Adventures, is investigating the possibility of launching a new company that 

will provide whale-watching tours to its own customers as well as other travel agencies . An 

important task is researching the financial viability of this new venture. 

1 Open the Whale Watching What-If workbook and save as: Whale Watching What-If – Student. 

 The cost of renting the boats is estimated to be about 25% of revenues, and fuel is another 35%. The 

remaining costs are fixed monthly expenses to operate a small office near the pier and to pay for various 

boat-related expenses. 

 This worksheet does not use the traditional income-statement format that is used for financial reporting 

purposes. The format used here is designed for profitability or CVP (cost-volume-profit) analysis. The 

variable elements including revenues and costs are placed together in the upper part of the 

worksheet; the fixed elements are placed together in the lower part. 

2 In the following cells, enter the specified formulas: 

Cell Formula 

B4 =B3*0.25 

B5 =B3*0.35 

B6 =B3-B4-B5 

B14 =SUM(B8:B13) 

B16 =B6-B14 

 With a monthly revenue of $15,000, this worksheet shows a loss of $2,250 a month. 

3 Select cell B1 and enter: 20,000. 

 Excel has quickly calculated a new net income of -$250, which clearly shows that the company will not 

break even at this revenue level. The term break-even point means the point at which total revenues match 

total expenses, leaving a net income of $0. Any revenue level above that will result in a profit  and any 

revenue level below that will result in a loss. 

4 Repeat step 3 with other revenue values to try to achieve a net income of $0. 

 You will have to make many guesses to achieve a break-even point. Each of your guesses will be too high 

or too low until you narrow your guesses down to the right number. 

5 Once you have a net income of $0, save and close the workbook. 

Learn the Skill 
This exercise will demonstrate the use of a what-if analysis to perform a simple break-even 
calculation. 
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Using the Goal Seek Tool 
When you create a worksheet, you enter formulas into cells and the results of your calculations are displayed in 

those same cells. This works well when you know all of the components required to create the formulas. But 

ery common 

business example is determining the break-even point for a new product. The trial-and-error method works, 

but it becomes tedious, especially considering that you have the ability to access the enormous computing 

power that modern computers have. A much easier solution is to use the Goal Seek tool in Excel. 

The Goal Seek tool automates the entire process of changing one variable while calculating a formula and 

trying to match the desired value. In a break-even situation, you can set the Goal Seek tool to change the 

number of units produced while checking the profit calculation for a 0 value. Using this tool, you can easily 

determine the impact of a 10% increase in labor cost on the number of units needed to break even. 

The variables used to perform the Goal Seek are as follows: 

 

Set cell Select the cell in which you want Excel to display the result of your goal-seeking. This cell 

must contain a formula that will calculate the result you want using values from other cells in 

the worksheet. 

To value Enter the end result (value) that you want to achieve. It must be a numeric value it cannot 

be a formula or reference a cell. 

By changing 

cell 

Select the cell in which you want Excel to display the variable result of your goal-seeking. This 

cell must not contain a formula. If you imagine that you had to perform the what-if analysis 

without the Goal Seek feature, you would have to continuously change this cell value. 

When using the Goal Seek tool, keep the following in mind: 

 The Goal Seek feature is a tool; it is not a function. That is, it changes the value of the variable cell to 

achieve the desired goal. If you change any of the values or formulas involved with the results, you must 

run the Goal Seek tool again. 

 The cell displaying the outcome must contain a formula that is dependent on the variable cell, either 

directly or indirectly. 

 You can reverse any changes you make with the Goal Seek tool by using the Undo feature. 

 

1 Open the Whale Watching Goal Seek workbook and save as: Whale Watching Goal Seek – Student. 

2 Select cell B16. 

3 On the Data tab, in the Data Tools group, click What-If Analysis, and click Goal Seek. 

 The Goal Seek dialog box appears with the Set cell text box referring to the answer cell. 

4 Select the To value text box and set the value to: 0. 

Learn the Skill 
This exercise demonstrates how to use the Goal Seek feature to perform the what-if 
analysis that you did manually earlier. 
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5 Select the By changing cell text box and type: B3 or use the mouse to select cell B3. 

6 Click OK to initiate the Goal Seek analysis. 

The Goal Seek tool displays the result on the Goal Seek Status dialog box. If Excel is able to find a solution, 

the Target value and Current value will be the same. The Goal Seek dialog box should appear as follows: 

  

Unlike the previous exercise, which involved a lot of guesswork, this feature quickly calculates the answer for 

you. 

7 Click OK in the Goal Seek Status message box to accept the results of your goal-seeking. 

Now determine what the revenue needs to be if certain expenses are higher than expected and you want to 

achieve a net income of $5,000. 

8 Change cell B8 to: 3,000 and B12 to: 700. 

9 Repeat steps 2 to 7 to determine the revenue with a target net income of $5,000 per month. 

 The worksheet should look something like the following screenshot. 

  

10 Save and close the workbook. 

Using the Solver 
You have seen how the manual method of what-if analysis works enter a value into one or more cells and see 

if the results match what you are looking for. Most likely, you will not get the right results on the first attempt, 

so you have to continue entering different values into these same cells until you do. 

The Goal Seek feature automates this process by quickly entering different values until you find the right 

solution. This works well when there is only one variable to be changed. But if you have more than one 

variable, you need to use a mathematical tool known as linear programming. 

Linear programming has many applications in the real world, such as determining the mix of products to 

manufacture based on costs, ability to manufacture, profit, and ability to sell. On a personal level, you may use 

this tool to help you determine mortgage terms and payments that fit your budget. 
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The Solver is a powerful and flexible tool that Excel provides to help you solve these types of problems. The 

linear programming model consists of three components: 

 The first component is the Objective Function (called the Objective in the Solver), which Excel optimizes. 

You can choose to Maximize or Minimize, or choose a Value of number for this objective function. You 

can tell the Solver to find the right numbers to reach a specific value in this cell, as you can with Goal Seek. 

However, you can also ask the Solver to find the highest or lowest possible number without specifying 

what that number is. This is a good option because, in many situations, you will not know what could be 

achieved. 

 The second component is the Decision Variables  (called Variable Cells in the Solver), which are the 

Objective Function variables that you will modify to determine the optimal solution. These are the 

numbers that the Solver will find to help you get the results you want in the Objective Function. You can 

run the Solver that comes with Excel 2010 with up to 200 variables. You can also purchase premium 

versions from Frontline Systems, the developer of this tool. Depending on the version, these premium 

versions can handle 2,000, 8,000, or an unlimited number of variables. 

 The third component is the Constraints, which are the limits or conditions you impose on the model. 

Although constraints may not at first seem to be important, they are in fact crucial to the process. Without 

them, the Solver creates meaningless solutions. You must look at each cell in the worksheet that affects 

both the target cell and the changing cells to determine if there are any limitations or constraints. Using 

the mortgage example, you will want to add several constraints, such as: 

- Your total expenses, including your mortgage payments, cannot exceed your take-home pay. 

- Your monthly payment (and possibly other home-related costs) cannot exceed 30% of your gross 

income. This is a limitation imposed by most banks and financial institutions.  

- Your mortgage amortization period cannot exceed the maximum number of years permitted by your 

bank.  
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With previous versions of Excel, you usually had to add constraints to prevent the Solver from setting variable 

cells to negative (i.e., less than zero) values. In Excel 2010, you can select the Make Unconstrained Variables 

Non-Negative option as a default. However, if you do specify an explicit constraint that sets a lower limit for a 

cell, the Solver will interpret this constraint as an override. 

The Solver tool also allows you to choose from three different linear programming engines. The GRG nonlinear 

method is the default, and is most appropriate for fairly simple problems involving only a few variables but 

possibly complex formulas. The simplex LP method is designed for simple problems with few variables and non-

complex formulas. The evolutionary method is designed for complex worksheets with multiple variables and 

complex formulas that interact with each other. Each engine has its own strengths and weakness. When in 

doubt, run the Solver with each of the engines and see which one produces the results closest to what you 

want. 

 

In some situations there may be more than one workable solution to the problem. In this case, you can 

influence the solution that the Solver produces through the starting values you choose. Set the variables to 

your best guess to produce the optimal solution you are seeking; if the Solver finds a different solution, change 

the values and rerun the Solver. 

If the Solver cannot find a solution, carefully review your worksheet functions and constraint equations, 

keeping in mind that, with the number of variables involved, it is easy to make an error. 

The Solver tool is not activated in Excel by default; it 

is an optional add-in. If the Solver item does not 

appear in the Analysis group in the Data tab (or the 

Analysis group is not displayed at all), you must 

use the Excel Add-in manager to install it. 

  

 

Learn the Skill 
This exercise demonstrates how to use the Solver to calculate the number of boats to buy. 
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Instead of renting, Tolano Whale Watching has the opportunity to buy the boats needed for the business. The 

suppliers currently have 10 boats available for sale. In order to decide how many boats to buy, Tolano 

Adventures needs to perform some financial calculations. 

1 Open the Whale Watching Solver workbook and save as: Whale Watching Solver – Student. 

 The left side of this worksheet looks something like the What-If and Goal Seek tools, except that the boat 

rental cost has been replaced by boat loan payments. On the right side of the worksheet is the financing 

cost calculation for buying the boats. 

The first step is to calculate the monthly cost of the loan. 

2 Enter the following formulas in the specified cells: 

Cell Formula 

E10 =E7*E8 

E13 =PMT(E11/12,E12*12,-E10) 

Now enter the remaining formulas to calculate the net income. 

3 Enter the following formulas in the specified cells: 

Cell Formula 

B7 =E13 

B14 =SUM(B7:B13) 

B16 =B5-B14 

An analysis has determined that each boat will generate an estimated $5,000 of revenue per month. This 

information is very useful for doing CVP analysis, so modify the revenues cells to reflect this. 

4 Select cell B3 and enter: =E7*5000. 

The worksheet shows that, with three boats, Tolano Adventures will incur a small loss each month. Now use the 

Excel Solver to calculate the optimal number of boats to buy. 

5 On the Data tab, in the Analysis group, click Solver. 

If the Solver does not appear in the Ribbon, you will have to load it. To load the Solver, click the File tab and 

click Options. In the Excel Options dialog box, select the Add-Ins category. Click the Manage drop-down 

button at the bottom of the dialog box, select Excel Add-ins, and click Go. In the Add-Ins dialog box, click the 

Solver Add-in check box to turn it on, and click OK. 

The Solver Parameters dialog box is displayed to allow you to set up the linear programming model. 

6 Click in the Set Objective text box, delete any cell reference it contains, and select cell B16 from the 

worksheet. 

7 Verify that the Max option is selected in the To section of the dialog box. 

 When you select By Changing Cells, the Solver puts different values into these cells to achieve the goal you 

designated in step 6, which is maximizing net income. For this exercise, the only variable is the number of boats 

(cell E7) to buy. This number determines not only the total amount borrowed and the monthly payment, but 

also what your monthly revenues are. 

8 Click the By Changing Variable Cells text box and select cell E7 (# of boats) from the worksheet. 

 For this exercise, assume you were informed that there is only a maximum of 10 boats available to buy. This will 

be the first constraint you will add. 

9 Click Add in the Subject to the Constraints section of the dialog box. 

 The Add Constraint dialog box appears. This dialog box is used to add one or more constraints to the Solver 

Parameters dialog box. 

10 Click the Cell Reference field of the Add Constraint dialog box and then select cell E7 from the worksheet. 
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11 In the Constraint field type: 10 and click OK. 

  

 You must also ensure that the number of boats Tolano buys is a whole number buy a 

quarter or half of a boat! Use the int operator to designate this.  

12 Click Add again to add another constraint. 

13 In the Cell Reference field, select cell E7 from the worksheet again. 

14 In the middle field, click the drop-down button, select int, and click OK. 

 Another common constraint is ensuring that numeric cells contain only positive numbers, as negative numbers 

may lead to erroneous solutions. 

15 Click the Make Unconstrained Variables Non-Negative check box to turn it on. 

For this exercise, you will use the simplex LP method for the linear programming calculation. 

16 If necessary, click the drop down button for Select a Solving Method and select GRG Nonlinear. 

 The Solver is now ready to run. 

  

17 Click Solve. 

 The Solver Results dialog box displays a message stating that the Solver was able to find a solution. 
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18 Click OK to accept the new values. 

  The worksheet should look something like the following image. 

  

 The Solver has determined that the Net Income is maximized by buying the maximum allowed number of 

boats, even though each boat cost $50,000, resulting in a monthly loan payment of $5,551. 

19 Save and close the workbook.  

 

 

 

 

 

 

You will now use the Solver to help you decide whether your personal budget is adequate to purchase a new 

house. The Objective Function is the calculated difference between your take-home pay and your expenses. It 

cannot be less than zero, but it will not likely be greater than zero because you want the best house you can 

afford. 

1 Open the Mortgage Solver workbook and save as: Mortgage Solver – Student. 

2 Enter the following formulas in the specified cells: 

Cell Formula 

B2  =B1*0.4 

Learn the Skill 
This exercise demonstrates a more complex application of the Solver tool in which it will 
change two variables at the same time. 
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B3  =B1-B2 

B5  =E10 

B8  =SUM(B5:B7) 

B10 =B3-B8 

E6  =E4-E5 

E10 =PMT(E8/12,E9*12,-E6) 

 It appears that your current income level does not support this mortgage.  

You will have to change the house price and the mortgage term to find an affordable 

solution. Instead of trial and error, you will use the Solver to find the best solution. 

The Goal Seek tool cannot be used to calculate the solution because more than one 

variable needs to be changed specifically, the price of the house (cell E4) and the 

length of the mortgage term (cell E9). To keep the exercise simple, 

your income and personal expenses cannot be changed.  

 3 On the Data tab, in the Analysis group, click Solver. 

4 Click in the Set Objective text box, delete any cell reference that may be in it, 

and select cell B10 from the worksheet. 

5 Select the Value of option and, if necessary, enter: 0 (zero) in the value text box. 

 You want the Solver to change two variables: the price of the house (cell E4) and the amortization term (cell E9) 

of the mortgage. You cannot change the interest rate, and the down payment is already the maximum you can 

afford, so these two cells in the Solver. 

6 Select the By Changing Variable Cells field. 

7 Select cell E4 (Price) from the worksheet. 

8 Hold  and select cell E9 (Term) from the worksheet. If necessary, move the Solver Parameters dialog 

box to make cell E9 visible or click Collapse. 

 Add a constraint to ensure the monthly payment cannot exceed 30% of your Gross Pay. 

9 Click Add in the Subject to the Constraints section of the dialog box. 

10 Select the Cell Reference field of the Add Constraint dialog box and then select cell B5 from the 

worksheet. 

11 Select the <= constraint operator. 

12 In the Constraint field type: B1*0.3. 

13 Click OK. 

 Now click the check box to prevent any of the numbers from being negative. 

14 If necessary, click the Make Unconstrained Variables Non-Negative check box to turn it on. 

15 Click the drop down button for Select a Solving Method and select Simplex LP. 

The Solver is now ready to run. 

This loan payment 
calculation function is valid 
in the United States where 
mortgage interest is 
compounded monthly. The 
function is not correct in 
Canada where mortgage 
interest is compounded 
semi-annually. 
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16 Click Solve. 

 The Solver Results dialog box displays a message stating that it could not find a solution. 

  

 If the Solver returns an error message or the results of the Solver are not satisfactory, you can 

restore the original values, make some adjustments, and rerun the Solver program. 

17 Click the Restore Original Values option to select it, click the Return to Solver 

Parameters Dialog check box to turn it on, and click OK. 

 Use a different linear programming model for the Solver to see if that would work. 

18 In the Solver Parameters dialog box, click the drop down button for Select a Solving 

Method, and select GRG Nonlinear. Click Solve. 

 This time, the Solver Results dialog box states that a solution was found. However, the Term value in cell E9 

shows a mortgage term of 27 years. Add the new constraint to the dialog box. 

19 Verify that the Return to Solver Parameters Dialog check box is turned on and click OK. 

You can also 
click Cancel and 
then start the 
Solver again. 
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20 In the Solver Parameters dialog box, click Add. 

21 Set the Cell Reference to cell E9 of the worksheet, select the <= constraint operator, and set the 

Constraint value to: 25. 

22 Click Add in the Add Constraint dialog box to add another constraint. 

23 Set the Cell Reference to cell E9 of the worksheet again, select the int operator, and click OK. 

 The last solution set was also unsatisfactory because the Solver was set to achieve a net amount of $0.00. What 

you really want is the best (most expensive) house that you can buy with your income. 

24 Click in the Set Objective text box, delete the current cell reference, and select cell E4. 

25 Click Max in the To section. 

 You now have to add another constraint to ensure the net amount is zero. 

26 Click Add to add another constraint. Set the Cell Reference to cell B10 of the worksheet, select the = 

constraint operator, set the Constraint value to: 0, and click OK. 

  

27 Click Solve. 

 This time the Solver came up with a solution that meets your needs. 

28 In the Solver Results dialog box, verify that the Keep Solver Solution option is selected, click the Return 

to Solver Parameters Dialog check box to turn it off, and click OK. 

  

29 Save and close the workbook. 
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What-If Analysis 

Whale Watching What-If – Student

Cell Formula 

B4 =B3*0.25 

B5 =B3*0.35 

B6 =B3-B4-B5 

B14 =SUM(B8:B13) 

B16 =B6-B14 

20,000

Learn the Skill 

3.2.2 
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Using the Goal Seek Tool 
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B3

3,000 700

Using the Solver 
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- 

- 

- 
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Learn the Skill 
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 Whale Watching Solver – Student

Cell Formula 

E10 =E7*E8 

E13 =PMT(E11/12,E12*12,-E10) 

Cell Formula 

B7 =E13 

B14 =SUM(B7:B13) 

B16 =B5-B14 

 =E7*5000
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 Mortgage Solver – Student

Cell Formula 

B2  =B1*0.4 

Learn the Skill 
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B3  =B1-B2 

B5  =E10 

B8  =SUM(B5:B7) 

B10 =B3-B8 

E6  =E4-E5 

E10 =PMT(E8/12,E9*12,-E6) 

0

B1*0.3

This loan payment 
calculation function is valid 
in the United States where 
mortgage interest is 
compounded monthly. The 
function is not correct in 
Canada where mortgage 
interest is compounded 
semi-annually. 



Data Analysis  Lesson 4 

 

3244-R0 © CCI Learning Solutions Inc.  153 

 

You can also 
click Cancel and 
then start the 
Solver again. 
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